
Site Recorder Technical Note 3 
3D Survey Procedure 

 
This technical note is to be used with Site Recorder 4 and Site Recorder 4 SE Version 
4.23.10 although the principles apply to all versions of these programs. 

Introduction 
This technical note describes the procedure used to process measurements from a 3D 
trilateration survey.  For this type of survey, direct distance measurements are made between 
survey points in and around the site to be recorded.  This method provides the highest 
positioning accuracy and should be used for pre-disturbance surveys and all excavation 
recording. 
 
The basic principle of this method of surveying is to record distance and depth measurements 
between survey points and then use Site Recorder to calculate the best position of the points.  
Distance and depth measurements are often recorded incorrectly and the procedure below 
describes how Site Recorder can be used to find any mistakes. 
 
The technique described here uses the Control / Detail method where a few survey control 
points are used to position many survey detail points which are in turn used to position 
artefacts and structure.  This method is preferable to the ‘Everything’ method where all survey 
points are treated equally and measurements are made between all of them.  The Control / 
Detail method uses fewer measurements and is easier to find mistakes. 
  
Depth measurements MUST be added for all survey points, both control and detail.  Typing in 
the depth of the survey point is not enough and a separate depth measurement must be 
added.  Failure to add depth measurements may result in the position calculation not working 
correctly. 
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Adding Control Points 
The first step is to add a network of survey control points around the outside of the site.  As 
few points should be used as possible and they should all be within 15-20m (50 - 65ft) of the 
other nearby survey points. 
 
 
Survey Points can only be added to Survey type Layers 
 
1 Show the Survey Toolbar.  From the View Menu select Toolbars then Survey Toolbar 

 
 
2 Select a Survey Layer for control points as the current Layer in the Layer Display.  Click 

on the Layer in the list then click the Set Current button . 

 
 

3 On the Survey Toolbar click the Add Survey Point button  

4 Click on the chart in the approximate position where the new point should be added.  
The Properties Pages for the new Survey Point will be displayed. 

 
 
5 Type in a new name for the point or use the default. 
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6 Set the Depth of the point and click OK 

7 Click again on the chart to add another Survey Point repeating steps 4 to 6.  Or click the 

Select button  on the Main Toolbar to stop adding points. 

 

Adding Distance Measurements 
Added between two Survey Points 

1 On the Survey Toolbar click the Add Distance button  

2 Left click and hold down the mouse with the cursor on the Survey Point to measure from. 

3 Drag the mouse cursor to the Survey Point to measure to and let go.  If the 
measurement was added successfully the property Pages for the new measurement are 
shown. 

 
 
4 On the Properties tab, type in the recorded distance measurement in the Value property 

then click OK.   

5 Click and drag again between two Survey Points to add another distance measurement 

repeating steps 2 to 4.  Or click the Select button  on the Main Toolbar to stop 
adding measurements. 

 
The default Value shown when the measurement is first created is the expected 
measurement based on the current positions of the two Survey Points. 
 

Adding Depth Measurements 
Adding depth measurements is very important and a measurement should be added to every 
survey point. 

1 On the Survey Toolbar click the Add Depth button  

2 Click on the survey point to add the depth measurement to.  If successful then the 
Property Pages for the depth measurement will be shown. 

3 On the Properties tab, type in the recorded depth measurement into the Raw Depth 
property then click OK.  
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4 Click on another Survey Point to add a new depth measurement repeating step 3.  Or 

click the Select button  on the Main Toolbar to stop adding measurements. 

 
The default Raw Depth shown when the depth measurement is first created the current depth 
of the point. 
 

Calculating Positions 
We can now calculate new positions for the Survey Points using the 
measurements added earlier.  The measurements are used to 
calculate the best estimate of the positions of the points and we can 
also calculate how well all of the measurements fit together. 
 
To calculate the positions of the points: 

• Click the Adjust button to compute positions for the 
points from the measurements.  If successful the message 
‘Adjustment completed OK’ will be shown along with the 
Statistics display. 

 
The Statistics display shows the RMS Residual, a value showing how 
well the measurements fit with each other.  Any value below 0.050 is 
acceptable but values of 0.015 or lower is considered good.  Larger 
numbers show that some of the measurements that have been added are
to be removed. 

 mistakes and need 

 
After positioning the best position for the points the software can calculate what each distance 
or depth measurement should be to fit with those positions.  The measurement residual is the 
difference between the measured value and the calculated value for that measurement.  For 
each measurement added earlier we can calculate what the value should have been to best 
fit with the others then work out the difference between that and the value we typed in.  The 
average or RMS of those residuals gives us a figure to show how well the measurements fit 
together and how accurately we have recorded the positions of the points.  The computed 
value and residual for each measurement is shown alongside the recorded measurement in 
the measurements’ Property Pages. 
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On the chart the measurements are coloured according to whether they are too long or too 
short.  Recorded measurements that are too long (residual is a positive number) are shown in 
blue, those that are too short are shown in red and those that are correct are shown in green.  
Ideally all measurements should be green however it is common to have a mix of colours at 
the start. 
 
We can improve on this result by allowing the software to automatically remove the 
measurements that are wrong using the Auto Rejection Tool. 
 
To use the Auto Rejection Tool: 

1 On the Adjust Toolbar, click the Auto Rejection button  

2 Click the Adjust button to recompute the positions of the points 

 
After using the Auto Rejection tool the results have improved: 
 

 
 
The measurements now include some that are coloured magenta as these have been 
rejected by the Auto Rejection tool.  The RMS of residuals value will also have reduced 
showing that there are now fewer bad measurements being used in the calculation.  
Measurements that have been highlighted in magenta should be remeasured or set to be not 
used in the calculation. 
 
To select a measurement not to be used: 
 
1 Double click the measurement on the chart or in the measurements list to show its 

Property Pages 

2 On the Properties tab, click the Is Ignored property check box so a tick is shown 

3 Click OK 

Measurements that are set be ignored are shown in black on the chart.  These measurements 
are not used in the position calculation. 
 
This part of the processing is complete when there are sufficient measurements added and 
the RMS Residuals value is below 0.050m. 
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Adjustment Problems 
Occasionally the position calculation does not work properly.  If after pressing the Adjust 
button the program shows this message then the positions of the points cannot be calculated 
from the measurements. 
 

 
 
The problem is that something is wrong with one or more of the measurements and this can 
be caused by a number of reasons: 
 

• Not enough points have depth measurements 
• More than one measurement has been added between the two same points and the 

measurements are very different. 
• All measurements to one point are too short, shown in red on the chart 

 
Assistance with identifying problem measurements is given by the Analyser Tool; this looks at 
the points and measurements and suggests where problems may be found. 
 
To show the Analyser Tool: 

• On the Adjust Toolbar, click the Analyser button  
 
 

 
 
 
More information about the Analyser and solving adjustment problems can be found in the 
manual, accessed via the Help menu in Site Recorder. 
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Fixing the Control Points 
With the survey control points positioned correctly we 
can now fix their positions.  The positions need to be 
fixed so the addition of any detail points and 
measurements does not affect the control point 
positions. 
 
To fix the Survey Points: 
 
1 On the Layer Display, click the Layer containing 

the Survey Points then right click to show the 
context menu 

2 In the context menu click Fix/Unfix Survey Points 

 
To confirm that a point is fixed, double click it to show its properties and ensure that the Is 
Fixed property check box is ticked. 
 
The measurements between the fixed control points are now no longer used in the 
adjustment so can be hidden. 
 
To hide the measurements between points on a Layer: 
 
1 On the Layer Display, click the Layer containing the Survey Points then right click to 

show the context menu 

2 In the context menu click Show/Hide Measurements 

 

Adding Detail Points and Measurements 
With the control points added, positioned and fixed we can now add the survey detail points 
used to record the positions of artefacts and structure.  The procedure for adding detail points 
and measurements to them is the same as described above used for survey control points. 
 
1 Select a Survey Layer for detail points as the current Layer in the Layer Display.  Click 

on the Layer in the list then click the Set Current button . 

2 Add a detail Survey Points as described earlier using click the Add Survey Point button 

 on the Survey Toolbar. 

3 Add distance and depth measurements to the detail survey points using the Add 

Distance button  and Add Depth button  on the Survey Toolbar 

4 Adjust the positions of the detail points using the Adjust button  on the Adjust 
Toolbar  

5 Re-measure any measurements that are identified as mistakes by the adjustment 

 
Small finds can be positioned using a single survey detail point but longer objects such as 
guns and anchors should be positioned with two or more so the orientation of the object can 
be shown.  Vessel structure should be positioned using multiple detail points. 
 
Avoid making measurements between detail points unless they are points on the same object 
such as the two end points used to position a cannon. 
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Separate the detail points on different types of objects onto different layers, so put the points 
used to position artefacts, guns and anchors on separate layers. 
 

 
 
 
 
 
 
 
 
 
 
 

Technical Support 
The online help document in provides further information on this subject.  To show this 
document, select Help Topics from the Help menu. 
 
More information about survey point network design can be found in the Nautical Archaeology 
Society Handbook 2nd Edition. 
 
More information and example Site files can be found on the 3H Consulting web site found at:  
 
http://www.3HConsulting.com 
 
Faults and software problems should be reported to 3H Consulting Ltd by email, describing 
the nature of the problem and if possible the steps taken to reproduce it. 
 
In some instances it is helpful to know the configuration of the computer showing the reported 
problems.  The full configuration can be found using the System Information tool found on the 
About dialog available from the Help menu. 
 
Support can be obtained directly from 3H Consulting Ltd. by sending an email to:  
 
info@3HConsulting.com 
 
 
Version 1.1 Aug 2008 
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